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I NSTALLING T IME STORM
Host System Requirements
Linux
Operating System
Version

RedHat Enterprise Linux 5 Desktop
Fedora 11
Ubuntu 9.0.4
Other recent 32-bit and 64-bit Linux distributions

Memory

512 MB

Disk Space

220 MB

What TimeStorm Installs
The TimeStorm IDE installs everything it needs to run during the initial installation.
TimeStorm is written in Java and native code, in order to ensure that no
incompatibilities arise when using TimeStorm with the default version of Java on the
host machine, TimeStorm installs a Java Runtime Environment that it alone uses.
In order to compile programs TimeStorm must have a toolchain. By default
TimeStorm uses the toolchain on the system. LinuxLink Starting Points as well as
builds using the LinuxLink Factory build system provide cross-compilation toolchains.
The installation process for a LinuxLink Starting Point puts the toolchain and any other
supporting files in the correct location, no additional configuration is necessary.
Working with Toolchains is described later in this guide.
In order to communicate with the target, TimeStorm must be able to communicate
with the board using one of several methods. TimeStorm can use telnet/ftp or
ssh/scp to communicate with the board. TimeStorm has been tested using busybox
telnetd, inetutils telnet/ftp servers and the dropbear ssh/scp servers. As an
alternative, TimeStorm can communicate with the board over a connection to the
serial console and copy files into a local NFS share if the above network services are
not available.
In order to use TimeStorm, it must have a valid license. The license management is
described in the following chapter.
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License Management
TimeStorm 4.0 uses node-locked licenses. After installing TimeStorm software, you
must install the software license file that enables the features that you have
purchased. A node-locked license enables TimeStorm features on one machine only
and is restricted to the hardware address of the machine. The licenses are keyed to
the MAC address of the system . Node-locked licenses are text files with a .lic file
extension. You need to create a license and install the license as described below.
The TimeStorm 4.0 license system is based on a different technology than the
TimeStorm 3.X series of products. You must obtain a new license for TimeStorm 4.0.
Once a license is installed and used, it cannot be moved to a machine with a different
MAC address. You can move the license to a different machine by create a new
license and installing it on the next machine.

Creating a TimeStorm License
To create a license for TimeStorm tools, you must have a LinuxLink set assigned to
you. You can create a new license for TimeStorm three times within the life of the
subscription. If you need to create additional licenses beyond this limit, contact
Timesys. These requests are handled on a case-by-case basis. To create a license:
1. Note the MAC address of the machine on which you will be using TimeStorm.
You may use any of the network interfaces.
2. Log into your LinuxLink account via a web browser.
3. On LinuxLink web account, access the team management features for your
team by clicking on the team name. Click the Edit Licenses button in the
Active Licenses area, and then click Create next to the user for whom you want
to create the license.
4. Enter the MAC address and a descriptive name for the license. It can be
helpful to include the type of operating system and computer that will use the
license. The license expiration date and the user's e-mail address are entered
automatically. Note that the MAC address can be entered with hyphens or
colons separating the number pairs, or with no separators at all.
5. Select to create a license for TimeStorm 4.0. Licenses generated for
TimeStorm 3.X will not work with TimeStorm 4.0. Be sure to select the
correct version when generating the license.
6. Click Next to generate the license. You are give the option of editing the CC
field and the text of the message that will be used to send the license file.
7. Click Send. The e-mail with the attached license is sent, and the contents of
the license file are displayed.
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8. Save the license on the computer you will be using for TimeStorm. LinuxLink
will keep the license on file, so it can be retrieved at any time.

Installing the License
Installing a license involves copying your license file into the appropriate directory on
the TimeStorm host. License files are typically delivered as text file attachments to email messages from Timesys. You can rename a license file, but you must retain
the .lic file extension. To install the license locally, you can do one of the following:
1. Cut and paste the license text on the screen into a file and save with .lic file
extension on the TimeStorm host at a location described below.
2. Save the e-mailed license attachment on the TimeStorm host at a location
described below.
3. Click the Download link and save the license file on the TimeStorm host at a
location described below.
TimeStorm will automatically detect license files if they are stored locally on the
TimeStorm host in one of the following three location. TimeStorm checks all of these
directories for license files at startup time, in the order shown here:
1. <user home directory>/.timesys/timestorm/licenses
The TimeStorm user's home directory is typically something
like /home/<username> on Linux systems. If you copy the license here it will
work for this user for all version-compatible TimeStorm installations on this
computer.
2. <TimeStorm installation directory>/licenses
TimeStorm checks for a directory named licenses within the TimeStorm
installation directory. This licenses directory is created automatically when
TimeStorm is installed. Licenses installed in this directory will work for this
installation of TimeStorm only.
3. /etc/timesys/timestorm/licenses
TimeStorm checks for this directory under the system-wide configuration area
(/etc). This directory is not automatically create, you will need to create it
manually if you wish to store license under /etc. If you copy the license here it
will work for all version-compatible TimeStorm installations on this computer.

Installing TimeStorm
TimeStorm is provided both as a standalone IDE and as a series of plugins that can be
installed into a 3rd party Eclipse-based IDE. The standalone IDE is based on Eclipse
3.4 C/C++ edition. The TimeStorm plugins are compatible with Eclipse 3.3 (Europa)
and Eclipse 3.4 (Ganymede) and require the corresponding version of the C/C++
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Development Toolkit (CDT) to be installed. The TimeStorm plugins require Java 1.6
(Standard Edition).
To TimeStorm standalone IDE:
1. Download the archive timestorm-full-install-4.0.0.<build_num>.tgz.
2. Open a terminal and change directory to the location where you want to install
TimeStorm.

3. Use the following command to uncompress the archive on your host, and
extract its contents (the build number <build_num>, will vary):
# tar -zxf timestorm-full-install-4.0.0.<build_num>.tgz

4. TimeStorm is installed within the directory “timestorm-4.0”. You can start
TimeStorm with the following command:
# ./timestorm-4.0/timestorm

To TimeStorm plugins into Eclipse 3.3 (Europa):
1. Start Eclipse. Select from the Menu “Help->Software Updates->Find and
Install...”
2. Within the “Install/Update” dialog, choose “Search for new features to install”
and click “Next”.
3. Click “New Remote Site”. Enter the Name “TimeStorm Update Site” and the
URL “http://updates.timesys.com/timestorm”
4. Click “Finish” in the Install dialog.
5. Eclipse will connect to the update site and after a moment, a list of installable
features will be presented.
6. Open the TimeStorm Update Site and Timesys Products category and check
“TimeStorm 4.0”. Click “Next”.
7. The Timesys End User License Agreement (EULA) will be presented. Read this
agreement and select “I accept the terms”, if you accept the terms. Click
“Next”. (Accepting the EULA is required to install TimeStorm plugins.)
8. The features to install will be listed along with the install location. Click
“Finish” to confirm this information and begin installation.
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9. The TimeStorm plugins will be downloaded and installed. Timesys does not
sign its plugins, and the installation of unsigned plugins must be confirmed.
10.Once installation is complete, a prompt to restart Eclipse will appear. It is
recommended that you restart Eclipse to complete TimeStorm plugin
installation.
To TimeStorm plugins into Eclipse 3.4 (Ganymede):
1. Start Eclipse. Select from the Menu “Help->Software Updates...”
2. In the “Software Updates and Add-ons” dialog, select the “Available Software”
tab.
3. Click “Add Site...” and enter the URL “http://updates.timesys.com/timestorm”
4. Expand the newly added site and the “Timesys Software” category and check
“TimeStorm 4.0”. Click “Install...”.
5. Information about the plugins will be downloaded, after which a confirmation
screen will be presented. Click “Next...”.
6. The Timesys End User License Agreement (EULA) will be presented. Read this
agreement and select “I accept the terms”, if you accept the terms. Click
“Finish”. (Accepting the EULA is required to install TimeStorm plugins.)
7. The TimeStorm plugins will be downloaded and installed. Timesys does not
sign its plugins, and the installation of unsigned plugins must be confirmed.
8. Once installation is complete, a prompt to restart Eclipse will appear. It is
recommended that you restart Eclipse to complete TimeStorm plugin
installation.

Installing TimeStorm
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AND

E CLIPSE

TimeStorm is based on the Eclipse IDE, first published by IBM and now maintained by
the Eclipse foundation. TimeStorm is designed to conform to the Eclipse standards as
closely as possible, using as much of the existing user interface language as possible.
This section defines the basics of the Eclipse environment and explains how Timesys
extended Eclipse to add the features unique to embedded developers to make the
TimeStorm product.

Eclipse Terminology / Autonomy
Workspace
The workspace is the top-level container for all of the information kept by TimeStorm.
When starting TimeStorm, the user selects a workspace and uses only that
workspace. Users may have more than one workspace, but TimeStorm uses only one
at a time. When using TimeStorm, users can switch workspaces.

Projects
Projects in TimeStorm are different than workspaces in that the workspace contains
projects and projects are the entity responsible for creating binaries. A workspace
frequently contains several projects: one for building the application binaries, another
for creating library, etc . Using the workspace, these projects can be coordinated to
produce the software binaries for the target board.
Since workspaces are the top-level storage container, users frequently refer to
the workspace as the “project.”
TimeStorm projects are customized to enable remote execution and to automate
certain tasks related to an embedded application development.
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A TimeStorm project has the following important differences from a generic eclipse C
or C++ project:
TimeStorm Projects

Generic “Linux GCC” C and C++
projects

Allows you to select a toolchain from
the list of installed toolchains

Uses the default host toolchain

Provides additional source code
templates for creating new projects.

Hello World Executable template only.

Wizards
Every project in TimeStorm is created with a wizard. Wizard in TimeStorm ask the
user for basic project information and will create a simple, working project used as
the base for additional work.

Workspace
TimeStorm IDE graphical user interface is called the Workspace. Workspace features
are part of the standard Eclipse development environment, which serves as the basis
for TimeStorm IDE. The Workspace is composed of editors, views and perspectives.
The Eclipse Workspace is presented into one or more windows. These windows could
be either views or editors. A perspective defines the visual arrangement of the
Workspace windows.

TimeStorm and Eclipse
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Figure 1: TimeStorm Workspace

The Workspace is documented more completely in the online Workspace User Guide,
which is available from the TimeStorm Help menu.

Views and Editors
Views support editors and provide alternative presentations as well as ways to
navigate information in your workspace. For example, the Project Explorer view
displays projects in the current workspace. Views have their own menus. Some views
have their own toolbars. The actions represented by buttons on view toolbars only
affect the items within that view. Editors are stacked in the center. You can associate
different editors with different types of files. When you open a file for editing by
double-clicking it, the associated editor opens in the workspace.

Perspectives
You can rearrange the views and editors in your workspace as you wish, the saved
arrangements of views and editors are called Perspectives. There are no constraints
as to what views appear in a perspective; however, from a practical perspective, the
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views are typically related in some way. TimeStorm ships with several perspectives,
for example:
C/C++ Development: views and menu items that are customized for applications,
libraries and driver development.
Debugging: shows debugging tools and related views.
Source Code Control
When TimeStorm initially opens, it loads the C/C++ perspective by default. If you
create a new project of a different type, TimeStorm switches to the appropriate
perspective automatically. By default, TimeStorm saves your current perspective
settings when you exit TimeStorm and reestablishes it when you start again. If you
want the workspace to revert to the standard layout for the current perspective, use
the Window > Reset Perspective command.
These perspectives can be changed or additional perspectives may be created by the
user to match his working preferences.

Source Code Control Systems
TimeStorm relies on the Eclipse framework to provide integration with source code
control (SCC) systems. The open nature of Eclipse has resulted in integration of many
source code controls systems. TimeStorm users are free to select a SCC that best
matches their needs. Timesys has tested and validated the following SCC systems
with TimeStorm:
CVS
Subversion
Perforce
TimeStorm includes a CVS integration, while the Perforce and Subversion code must
be obtained separately.

Using Your Own Source Code Control System
TimeStorm can be used with more than just the list of tested and validated source
code control systems mentioned in the previous section. If the source code control
system in use at your company isn’t directly supported by TimeStorm, you can still
use it to manage your development tasks. There are two strategies, using a vendor
supplied plug-in or doing source code control from the command-line.

Using Source Code Control Plug-in
Many vendors have plug-ins that can be added to an existing TimeStorm installation.
Since TimeStorm is built on Eclipse, a plug-in that is compatible with the Eclipse used
to make TimeStorm can be used without modification. Follow the directions supplied
by the vendor to add the plug-in to TimeStorm.

TimeStorm and Eclipse
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Using Source Code Control Command Line
Some source code control systems do not have Eclipse-based plug-ins. You can still
use these, but you’ll need to do so from the command-line. When using a SCC
command-line tool, follow these guidelines

10

•

Don’t version control the .metadata directory
Under the workspace, TimeStorm maintains a .metadata directory. This
directory contains temporary information related to the workspace and should
not be checked into version control.

•

Don’t make any files starting with “.” Read-only
TimeStorm creates files in project directories starting with . to store any
project –related information. These files can be checked into version control,
but must read/write on the local file system. Some source code control
managers make all files read-only unless otherwise instructed.

•

When initially checking out a project, put in the directory of an existing project
To add the project to the workspace, create a project with the wizard (you can
delete all of the files) and use the SCC to do the initial check out of the project
files into that directory. After the check out, return to TimeStorm and refresh
the project by pressing F5 for TimeStorm to recognize the newly checked-out
files.

Installing TimeStorm
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E MBEDDED DEVELOPMENT

WITH

T IME S TORM

Embedded development is different from traditional development in that:


The target machine is usually a different hardware architecture than the host
machine



The target machine lacks the resources necessary to be used as a
development machine

Development Host and Target Board
The development host is the machine where TimeStorm runs and source code is
compiled for the target board. The target board is where the code compiled on the
development host will eventually be debugged and deployed. The reason why
engineers don’t do development directly on the target board is that it frequently does
not have the resources (like RAM or fixed storage), processing power or peripherals
(such as a monitor, keyboard or network connection) in order to support a
development environment.
TimeStorm bridges the gap between the more powerful development host and target
board through the following features:
•

Toolchain Management – TimeStorm keeps track of the toolchains
installed on the development host as part of the LinuxLink Starting Point or
created with the Factory build system.

•

Build Configurations – Build Configurations connect a toolchain with a
project. Each project can have many build configurations and each build
configuration can have its own settings to control how the software is built.
By default, TimeStorm creates three build configurations Release, Debug
and Profile for new projects.

•

Target Management – TimeStorm includes a tool for communicating with
a target so this information is stored in one location and shared by features
that need to reach a remote machine.

•

Remote Run/Debug Configurations – In order to run and debug the
code created for the target, TimeStorm includes Run and Debug
configurations that use the targets defined by the user to download code
and properly configure the run-time environment of the target.

Embedded Development with TimeStorm
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Working with Toolchains
Toolchains include the tools required to compile your applications. Toolchains that
you use with TimeStorm for remote development allow you to compile your
applications on one platform for use on another platform. They include appropriate
cross-compilers, debugging software, and other utilities that work with your target
processor. Build configurations for TimeStorm projects specify which toolchain to use
when building your project. You can set different toolchains in different build
configurations.
TimeStorm is designed to automatically detect Linux toolchains from Timesys Starting
Points that have been installed using the install shell script as the “root” user.

User-Supplied Tool Chains
If your toolchain is not from the Timesys Starting Point, you must import your
toolchain to make it available to TimeStorm. You must start TimeStorm and modify
the list of toolchains in TimeStorm's preferences settings. The Add Toolchain wizard
walks you through the process of defining a toolchain. If you do not import the
toolchain as described in this section, it will not be available for use in TimeStorm
projects. The next section gives detailed instructions for adding a user-defined
toolchain to your TimeStorm Workspace.
When using a toolchain that was not provided by Timesys, you must ensure the
toolchain's compatibility with TimeStorm and with the other elements of your
development environment. The toolchain must be GNU-based. Ensure that crosscompilers and other required utilities are available on the appropriate path and have
the correct permissions for access by the TimeStorm user. In order to perform remote
debugging in TimeStorm, the toolchain must include GDB version 5.2.1 or later.

Adding Your Own Toolchain
To display the list of toolchains that are recognized by TimeStorm, select Window >
Preferences from the main menu. The Preferences panel appears. Select TimeStorm
> Toolchains, as shown in Figure 2.
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Figure 2: Toolchain Management

Both automatically-detected and user-defined toolchains appear in this list. To add a
new user-defined toolchain, click the Add button. The Add Toolchain wizard starts.
The first step in the Add Toolchain wizard is to specify where the toolchain is installed.
Use the Browse button to specify the directory that contains the toolchain's binary
files. Figure 3 shows the completed form.

Embedded Development with TimeStorm
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Figure 3: Toolchain Management, Toolchain Directory

The next page will show the list of tools that are have been detected in the specified
directory. Toolchains using gcc with a cross-compiler prefix will be automatically
detected. Figure 4 shows a list of automatically detected tools.
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Figure 4: Toolchain Management, Tool Names

Each tool chain has a Name, Description, ID and a location. TimeStorm uses the
toolchain identifier (ID) as an internal reference; the name and description are used to
identify the toolchain to users. You can customize the name, description, and
identifier for this toolchain. Identifiers and names must be unique; that is, two
different toolchains on one system cannot have the same identifier or the exact same
name.
To View or Edit the toolchain properties, select the toolchain and click the View
button. However, Timesys toolchains that are automatically detected cannot be
edited. If you want to modify tools or properties for a Timesys toolchain, you must
add it as a user-defined toolchain. The next panel, shown in Figure 5, allows you to
Embedded Development with TimeStorm
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modify the toolchain's name and description. If your toolchain has acceptable default
values, modifying the name and description information is optional.

Figure 5: Toolchain Management, Name and ID

Managing Build Configurations and Managed Makefiles
TimeStorm uses build configurations to control how TimeStorm C and C++ projects
are compiled and built. A build configuration is a collection of build settings
associated with a project that contains the following information.
•

16

Compiler – What compiler to use to build the software. TimeStorm project
have the ability for the user to create Build Configurations that use a crosscompiler.
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•

Compiler Settings – Settings such as the optimization level, ANSI compliance
and warnings.

•

Linker Settings – Settings that specify what libraries to use and whey they
can be found.

By switching from one build configuration to another, you can quickly and easily
change the build settings for your project.

Types of makefile Management
TimeStorm has two different ways of managing the make files in a project, as outlined
below.
•

C/C++ Executable, Shared Library, and Static Library Projects– The
make files for these projects are generated using the setting from the build
configurations for the project. These projects may use a TimeStorm CrossCompile Toolchain.

•

Makefile projects – In these projects, the make file is under complete control
of the user. TimeStorm does not attempt to examine the project and generate
a make file before the build. Use this option when working with projects that
already have an existing make file, or when complete control of the make file is
necessary.

Build configurations are part of the project properties. To see the build configurations
for a project, right click on a project, select “Properties” then select C/C++ Build >
Settings. On the right part of the dialog, the current build configuration will appear.
Use the “Manage Configurations” button to add, rename or delete build
configurations.

Building with Host Compiler
Since TimeStorm allows the user to create multiple build configurations for a project,
users will frequently create a build configuration that executes the host compiler (that
is, the compiler that produces code to be executed on the host machine) so that the
program can be tested without the additional overhead involved with remote
debugging. Since most problems are algorithmic in nature, this strategy reduces the
amount of development time and is an oft-used strategy used by embedded
developers.
To access the build configuration panel, right click on the project, select Properties.
In the properties panel, select C/C++ Build > Settings.
To use the toolchain on the host machine, select the “Cross Toolchain” tab in the
build configuration panel and select the “Native Toolchain” option. The “Native
Toolchain” will be appended with text describing the type of platform (for example

Embedded Development with TimeStorm
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“(i686-linux)”). When using the host compiler, ensure that all of the libraries, both
inside of the workspace and toolchain have been compiled for the host platform.

Working with Hardware Targets
Before you can run and or debug on a remote target, you need to register information
about one or more targets with TimeStorm by using the Hardware Targets window.
TimeStorm uses this information to determine how and where data should be copied
to the target, and the method of communication that TimeStorm should use between
the host and the target.
The Hardware Targets window enables you to add a target to the list of registered
targets, edit the information for a registered target, delete a target from the list of
registered targets, or check connectivity from the host to a target.
You can access the Hardware Targets window either by clicking the Hardware Targets
toolbar button
, or by selecting Run > Hardware Targets from the main menu, as
shown in the following figure:

Figure 6: Hardware Targets Menu

Setting up a target requires three steps: how to download files to it, how to
communicate to execute on the target and how to test the connectivity between the
host and the target.

Downloading Files
TimeStorm allows files to be downloaded to the target in a few different methods.
•

FTP – Files will be downloaded from the host to the target using FTP.

•

SCP – Files will be downloaded from the host to the target using SCP.

•

None – The host will be connected to the target, but no data will be downloaded. You can then do
any needed downloading using the console.

•

NFS – TimeStorm will copy the files locally in the target Root File System (RFS) mounted over
NFS.

FTP/SCP Settings
The corresponding fields for both the FTP and SCP options are as follows:

18
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•

IP Address – Enter either the IP address or the hostname of the target. If you use a hostname,
your network must include access to a Domain Name Server (DNS) lookup facility.

•

User Name – Enter the user name for FTP or SCP login on the target, as appropriate.

•

Password – Enter a nonblank password for FTP or SCP login, as appropriate.

•

Destination Directory – Enter the path to which the files will be transferred on the target. FTP
settings sometimes restrict the location of files copied to a directory under the home directory of
the user. Therefore, the actual destination directory depends on the configuration of your FTP
software. In some cases, directories specified in this panel are appended to the user’s home
directory on the target. Ensure the user name that you specified has read/write permissions to the
destination directory.

•

Link to Execution – When this checkbox is selected, all of the information listed in the fields
corresponding to the FTP or SCP option is automatically entered into the fields in the Execute
tab. Those fields are not editable in the Execute tab when this checkbox is selected. This
checkbox is selected by default. When this checkbox is deselected, you must manually enter the
corresponding information in the fields in the Telnet option in the Execute tab.

NFS Settings
The corresponding fields for the NFS option are as follows:
•

RFS Base Directory – Use the Browse button to select the location of the RFS on the host. This
location is where the target’s root filesystem is mounted over NFS; for example,
/home/user/timesys/boardname/rfs, where user is the current username and
boardname is the name of the target board..

•

Destination Directory – Use the Browse button to select the location in the RFS to which the
files will be downloaded. The directory must be within the RFS Base Directory location that was
selected. Ensure that you have read/write permissions to the destination directory.

After you have entered the required information in this tab, select the Execute tab
and enter the appropriate information.

Executing Programs
Use the Execute tab to specify the communication method that TimeStorm uses
between the host and the target.
Within this tab, you can select Telnet, SSH, or a serial connection as the
communication method between the host and the target. You must fill in all of the
corresponding fields for the method that you choose. TimeStorm answers the login

Embedded Development with TimeStorm
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and password prompts presented by the Telnet or SSH server on the target, based on
the data that you enter in this tab.
•

Telnet – Communication between the host and the target will occur using Telnet.

•

SSH – Communication between the host and the target will occur using secure shell (SSH).

•

Serial – Communication between the host and the target will occur using the serial connection.

Telnet/SSH Settings
The corresponding field for both the Telnet and SSH options is as follows:
•

IP Address – Enter either the IP address or the hostname of the target. If you use a hostname,
your network must include access to a DNS lookup facility.

The execution IP Address field is also used when connecting to gdbserver for TCPbased remote debugging. This field must be provided regardless of connection
method to use TCP-based debugging.

Serial Settings
The corresponding fields for the Serial option are as follows:
•

Skip login – If you are connecting directly to the target’s bootloader, and thus will not get a login
prompt, select this option. The rest of the common details will be grayed out.

•

Serial Port – Enter the host's serial port; for example, /dev/ttyS0. If you use this option, be
sure that the user that you specified has the proper permissions to access the serial port.

•

Baud Rate – Use the dropdown list to select the appropriate baud rate for serial communication.
The default rate is 9600 bps.

Common Settings for All Options
The common fields for all three options in the Execute tab are as follows:
•

User Name – Enter your user name for a Telnet, SSH, or serial login, as appropriate, on the
target.

•

Password – Enter a nonblank password for the Telnet, SSH, or serial login, as appropriate, on
the target.

•

Working Directory – Enter the directory to which control will be transferred after TimeStorm logs
in to the target. By default, this is the same path to which the data will be transferred on the
target. This directory must already exist.
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If the Link to Execution checkbox is selected in the Download tab, the information in
the fields corresponding to the FTP or SCP option in the Download tab is automatically
entered into the common fields and the IP Address field in the Execute tab. In this
case, the fields are not editable as long as the Link to Execution checkbox is selected
in the Download tab.

Testing the Connection
After you register a target, you can check the connectivity to that target at any time.
Each time you add a target or edit information for a target, Timesys recommends that
you perform a connectivity check to verify that the host can communicate with the
target. The target connectivity check does not occur automatically upon registering or
applying changes to a target.
To verify connectivity to a target, select the target in the left pane of the Targets
window and click the Check Link button. The Raw Log tab becomes active when the
check starts.
A Target Check - Passed message is displayed in the Raw Log tab of the Targets
window if the host communicates successfully with the target:

Figure 7: Output from Check Link
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Run/Debug Configurations
TimeStorm IDE uses Run configurations to store download and execution information
for your applications. Although Run configurations are part of the basic Eclipse IDE,
TimeStorm Run configurations are customized to support executing and debugging a
program and its libraries on a remote target.
The C/C++ Development User Guide online help includes additional information about
TimeStorm's debugging tools.

Creating
To create a new run configuration, select Run > Open Run Dialog… from the main
menu. Select the type of configuration that you want in the Configurations list and
click new icon or double click the configuration type to add a new configuration. Then,
use the tabbed panels on the right to select and configure the run options. Different
options appear depending on the type of run configuration that you create.
TimeStorm projects typically use one of the following types of run configurations:
•

C/C++ Local Application – Runs a C or C++ project on the local system. Use
this option if when running or debugging an application built with the host
compiler

•

C/C++ Remote – Runs or installs a C or C++ project on a remote target. Use
this option to debug programs built with this cross-compiler.

Main Panel
In the Main panel, specify the project to run with this configuration. You can use the
Browse button to search for your project name. After filling in the project name, use
the Search Project button to find the executable file that you want to transfer and run.

Figure 8: Main Panel

Arguments Panel
In the Arguments panel, you can specify execution details for your application. Only
the C/C++ Remote projects have “Remote Working Directory” option
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Figure 9: Arguments Panel

C/C++ Program Arguments
You can specify values to pass to the application by typing them in the C/C++
Program Arguments field. Separate values with spaces. Values are passed in the
order in which you list them here.

Remote Working Directory
In the Remote Working Directory field, you can specify the directory from which to
run the application on the target. TimeStorm switches to this directory path before
executing the application.
If you do not change the value of this field from "." the application runs from the
target user’s home directory.

Command To Execute
In the Command to Execute field, enter the exact command to use when running the
application. This value is required. The default value is to run the specified program
within the working directory. Uncheck “Use default command” to change this value.
Keep in mind the directory structure on your target when constructing this command.
For example, if you have copied your application file to a directory named /apps but
you want to execute it from a working directory named /home/test, you must include
the path to your application in your command.
For example:
../../apps/my_app
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Environment Panel
In the Environment panel, you can set environment variables for the target.

Figure 10: Environment Panel

This panel contains the following buttons:
•

New – Click the New button to create a new entry. The New Environment
Variable dialog appears, as shown in the following figure.

Figure 11: Adding a New Environment Variable
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•

Click the Variables button to select the variables that you want to use. Then,
click OK twice.

•

Select – Click the Select button to import environment variables from the host
file system.

•

Edit – To change an entry, select it from the list and click the Edit button.

•

Remove – To delete an entry, select it from the list and click the Remove
button.
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Debugger Panel
In the Debugger panel, you can configure how to debug your project.

Figure 12: Debugger Panel

This panel contains the following options:
•

Toolchain – Choose the toolchain to use from the drop-down list of defined
toolchains. The path to the debugger executable is set automatically when you
choose a toolchain from the list. By default, the toolchain will be the same as
the toolchain of the project.
To use a debugger in TimeStorm, you must associate the debugger with a
toolchain. You can associate any debugger with a toolchain that you define.

•

Stop at main() on startup – Select this checkbox if you want execution to
pause when your application starts. (This option is selected by default.)

•

Automatically track the values of variables – Select this checkbox if you
want to have the values of variables displayed in the Variables view while your
project is being debugged. (This option is selected by default.)

•

Debugger Options – This section of the panel includes two tabs. The Main tab
is shown in the previous figure:
o

Main – This tab includes the following fields:
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•
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o

GDB Debugger – This field automatically displays the default debugger
for the toolchain that you have installed and is read-only.

o

GDB command file – This field allows you to specify a .gdb-command file
using the Browse button. The debugger will execute the commands
specified in this file.

o

Connection Type – This field allows you to choose whether to use TCP
or Serial to establish a debugger connection between host and target.
Note that this connection is in addition to the execution-type that you
specified in your hardware target. In order to use serial, you must have
another serial port in addition to the one being used as the target
console.

o

GDB Server Port – This field lets you specify the port number used for
debugging when TCP connection type is selected. Only visible when TCP
connection type is selected.

o

Target device – This indicates the name of the serial device on the
target to use for the debugger connection. Host and target device must
be connected with an appropriate serial cable. This field is only visible
when Serial connection type is selected.

o

Host device – This indicates the name of the serial device on the host
(where TimeStorm is running) to use for the debugger connection. Host
and target device must be connected with an appropriate serial cable.
This field is only visible when Serial connection type is selected.

o

Serial baud – This indicates the baud rate to use on the serial line for
debugger communication. The default rate of 115200 should be used
unless you are having serial communication issues. This field is only
visible when Serial connection type is selected.

Shared Libraries – This tab is shown in the following figure:
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Figure 13: Shared Libraries

The Shared Libraries tab includes the following options:
o

Directories – This field specifies any additional directories for the
debugger to search to find shared libraries (with debugging symbols).
By default the debugger will automatically search the paths specified in
the project's build settings (see option below). Use the Add button if you
want to add other paths. Use the Up and Down buttons to move through
the list of directories. Use the Remove button to delete a path.

o

Load shared library symbols automatically – Select this checkbox if
you want these library symbols to be displayed as loaded in the Shared
Libraries view and if you want the debugger to hit any breakpoints in the
shared library project. (This option is selected by default.)

o

Stop on shared library events – Select this checkbox if you want the
debugger to stop at shared library events, even before it hits
breakpoints in the source code. (This option is not selected by default.)

o

Search linker paths from project build settings – Select this
checkbox if you want the debugger to automatically search all of the
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linker library path specified in the project's build settings. These will be
searched in addition to any paths specified in the Directories field above.
(This option is selected by default.)

Source Panel
The Source panel shows the location of the source files for the project.

Figure 14: Source Panel

The Source Lookup Path field shows the project being run, as well as any projects that
it references.
You can add arbitrary source file locations by using the Add button. These locations
are searched after the generic locations, from the top to the bottom item in order.
The other buttons to the right of the list allow you to edit, remove, or reorder the list
items, and to restore the default information.
Selecting the Search for duplicate source files on the path checkbox causes
TimeStorm to notify the user if it is unable to determine which source file corresponds
to an executing binary file. For example, if you have two source files with the same
filename in different directories of the search path, TimeStorm is unable to determine
which file is related to the binary file with that name. If this checkbox is selected,
TimeStorm displays a message and asks the user to select which file to use. This
checkbox is not selected by default.

Target Panel
The Target panel, allows you to select the hardware target used when you run the
application.
28
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Figure 15: Targets Panel

In the Target panel, use the drop-down menu to select a hardware target that you
have registered with TimeStorm. If you have not yet registered a hardware target,
click Manage targets to open the Hardware Targets management utility.
If you have problems maintaining a connection to the target when using this run
configuration, consider increasing the value in the timeout setting.
Settings made in the Launch Timeout panel only affect run configurations; they do not
affect timeout settings for the Console view or for any other use of Telnet or FTP.
TimeStorm Preferences panel. From the main TimeStorm menu, select Window >
Preferences and open the TimeStorm > Launch Timeout item.

Download Files Panel
In the Download Files panel, you can select the files that TimeStorm transfers to your
target. You can use this panel to download additional files to your target, along with
your application.
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The application specified in the File field is listed as [Target Program]. This is the
application that will be run. You can change where it is downloaded by selecting it
and clicking Edit.
If the program links in shared libraries, then these libraries will be downloaded to the
target as well and the Files field is listed as [Target Program and Libraries].
These libraries will be downloaded to the same location as the target program. To
download the program and libraries to separate locations, remove the default entry
and re-add each as a separate entry.
File paths are interpreted as relative to the target directory to which you download
files. If you transfer files by using FTP, the actual destination directories depend on
the configuration of your FTP software. In some cases, directories specified in this
panel are appended to the user’s home directory on the target.
This panel contains the following buttons:
•

Add File – Use the Add File button to specify additional files to transfer, along
with the application. These files are transferred every time you transfer the
application file.

•

Edit – To change where the application (or any other file in this list) is installed,
select it and click Edit to change its destination directory.

•

Remove – To eliminate a file from the items to download, select it in the list
and click the Remove button.

•

Download Now – The Download Now button copies files immediately, without
running the application.

•

Restore Default – The Restore Default button resets the panel to its initial
state (download only the application and its libraries).

Downloaded files overwrite any identically named files on the target without giving a
warning. TimeStorm will not create destination directories on the target, so be sure to
create them before launching the configuration.

Common Panel
The Common panel sets options for sharing this run configuration among multiple
projects.
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Figure 17: Common Panel

By default, run configurations are saved with the workspace state files, so they can
only be used with projects in the current workspace. (This setting corresponds to the
Local file radio button on this panel.) However, you can make the configuration
available for use in other workspaces by choosing the Shared file radio button.
When you select Shared file, the run configuration is saved as a .launch file that can
be imported into another TimeStorm workspace. Optionally, you can specify a
different location for the file so that it is more easily accessible to multiple projects.

Display in Favorites Menu
You can select whether to include this run configuration on the main Run and Debug
menus. For example, if you select the Run checkbox, the run configuration always
appears in the Run History submenu.
You can choose to include the run configuration in either menu, both menus, or
neither menu.

Launch in Background
Selecting the Launch in background checkbox causes this run configuration to run as
a background thread. Running as a background thread is the default value. Clear this
checkbox if you want to run in the foreground, along with other TimeStorm
processing.
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The other options in this panel are Eclipse features that are not currently supported in
TimeStorm.

Creating Application project
Application projects are created by using the New C or C++ Project wizard.
TimeStorm uses the existing CDT C and C++ Project wizards, but adds the ability to
select a cross-toolchain. By creating a project with cross-toolchain, TimeStorm will be
able to build the project with one or more of the toolchains placed on the system
when installing a LinuxLink.
Open the New Project wizard by choosing File > New > Project from the main menu
or by clicking the New button
of the button to choose Project.

. Optionally, use the drop-down menu to the right

Choose a C or C++ Project. The new C/C++ Wizard can be used to create several
different types of projects. This section will focus on creating a Executable project.
Shared and static library projects are covered in the Creating Static and Shared
Libraries section of the manual.
Under the Project Type heading, expand the Executable type and select the source
code template you would like to use. Under the Toolchains heading select the
TimeStorm Cross-Compile Toolchain. Figure 18 shows the wizard with these
selections.
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Figure 18: New C/C++ Project Wizard

The Select Configurations panel will appear next. In this panel, TimeStorm will
suggest creating three build configurations that contain the compilation settings for
the project. Build configurations work together with the toolchain and project to
create the makefile TimeStorm uses for the build. For more information on Build
Configurations, please see the section How TimeStorm Builds a Project.
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Figure 19: Select Build Configuration panel

By default, TimeStorm creates three Build Configurations for new projects:
•

Debug – this setting performs no code optimization and attaches complete
debugging information. These settings are designed make debugging as
easy as possible.

•

Release – this setting has the highest compiler code optimization settings.
The output will not include any debugging symbols. Code compiled with
this configuration is ready for production use.

•

GnuProfiler – this setting builds the software with debugging information
as well as code to collect profiling information via GNU gprof.

Press Next to create all of the above Build Configurations for the project.

34

Embedded Development with TimeStorm

TimeStorm User’s Manual
The next panel in the wizard asks the user to select a toolchain. The entries in this
list appear because the user has installed a Timesys Starting Point or have added the
toolchain manually. Please refer to section Working with Toolchains to understand
how TimeStorm manages toolchains. The toolchain can be changed later in the
project’s property page.

Figure 20: Select Cross Toolchain

After clicking on Finish, the project will be created in the Workspace.

Creating Static and Shared Libraries
Library projects are created by using the New C or C++ Project wizard. TimeStorm
uses the existing CDT C and C++ Project wizards, but adds the ability to select a
cross-toolchain. By creating a project with cross-toolchain, TimeStorm will be able to
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build the project with one or more of the toolchains placed on the system when
installing a LinuxLink.
Open the New Project wizard by choosing File > New > Project from the main menu
or by clicking the New button
. Optionally, use the drop-down menu to the right
of the button to choose Project. Choose a C or C++ Project.

Figure 21: New C/C++ Project Wizard, Creating Libraries

Static versus Shared Libraries
Static and shared libraries allow the user to place certain functionality outside of the
main program, frequently so the same library can be shared across projects. Static
libraries are incorporated by copying the bits into the main program at link time while
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shared libraries are linked into the program before it runs by a dynamic library loader.
Shared libraries can also be accessed when the program is running by loading the
libraries into memory and calling functions, without the linking step before the
program runs.
Library Type
Feature

Static

Shared

Output File Name

lib<project name>.a

Lib<project name>.so

Can Update at Run-time

No

Yes

Dynamic Loader Needed

No

Yes

Code Shared Across
Applications

No

Yes

Select the TimeStorm Cross-Compile Toolchain from the list of toolchains populated
installed from a LinuxLink Starting Point or added manually to TimeStorm. The
toolchain can be changed later in the Project’s Property page (see changing
toolchains using project property page). Next select the configurations: Debug,
Profile, and Release. After clicking on finish, the project will be created in the
Workspace

Editing and Building
After starting development using the wizard, TimeStorm works like a standard IDE.
When new files are added to the project, TimeStorm will add them to the project’s
make file and will use the program’s extension to determine what tool to use for the
build process.
Extension

Build Program

.c, .C

C compiler

.c++, .cxx, .cpp, .cc

C++ compiler

.s

Assembler

To add an include file, source file, or create a sub directory to a project, right click on
the project, choose New to see different file options. Give the appropriate file
extension when specifying the file name.
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To build the application, select Project > Build Project from the menu. TimeStorm will
build the project with the active build configuration and display any errors or
warnings in the problems view. During the build process, TimeStorm generates a
make file for the project based on the active build configuration as described below in
the How TimeStorm Builds a Project section of the manual. A project created by a
TimeStorm wizard is designed to build without any errors or warnings.

How TimeStorm Builds a Project
TimeStorm uses Build Configurations to control the project build process. When
creating a project using a wizard, several build configurations will be created by
TimeStorm and associated with the project. One of these build configurations is the
“active” configuration (as illustrated by the star in the diagram) and that will be used
by default when creating a build. Any build configuration can be selected as the
active configuration, as this concept exists so the user does not need to select which
build settings to use when creating a build.
The following diagram shows the relationship between the project, build
configurations, toolchains and the make files generated by TimeStorm.

Figure 22: Relationship Between Project, Build Configuration, Toolchain and Makefile

The following describes how TimeStorm uses the makefile and build config to build
the project. TimeStorm will use the default build configuration, following these steps:
1. Create a directory with the name of the build configuration
The output for the build is stored under a directory that matches the name of
the build configuration used for the build. If this directory does not exist, it will
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be created. TimeStorm must have the ability to create directories in the
workspace or this operation will result in an error.
2. Scan the project, create a makefile that invokes the appropriate build program
for the source file
Before the build process occurs, TimeStorm will scan the project for files it
knows how to build based on extension, ignoring files that it does not know
how to handle. For those files that it knows how to process, TimeStorm will
then examine the files, calculate dependencies, and emit a standard GNU
makefile
3. Execute the makefile, display results in the Console Window
After creating the makefile, TimeStorm uses GNU to perform the build. The
results of the build process are displayed in the Console window.
4. Scan the results, create markers for errors and warnings
After the build, the results are scanned and TimeStorm translates errors and
warnings for files into markers that appear next to the offending line and in the
problems view.

Remote versus Local Application Debugging
Application debugging can occur on the host machine or the target board, depending
on how the application was built. When debugging on the local machine, the program
needs to be built with the host’s compiler.
For most projects, it makes sense for most debugging to happen on the host machine,
as debugging remotely is slower due to the communications link. In addition, most
code problems are algorithmic in nature, meaning that the code itself contains
problems, independent of where the code is running. This means developers can be
very productive by debugging the code on their host machine and then recompiling it
for final testing on the target. Some things, like timing, performance or access to
specialized devices, cannot be tested on the host machine and in this case remote
debugging is the right tool to use from the start.

Debugging on the Development Host
When debugging on the development host, select Run > open Debug Dialog… from
the main menu and use the C/C++ Local Application configuration from the debug
run configuration dialog.
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This run configuration shares many of the same panels as the C/C++ Remote Run
configuration and works in much the same way. Just like with the C/C++ Remote Run
configuration, the user needs to specify what project and application will be used for
debugging and has control over the environment variables and source code locations.

Development Host Debugging Strategies
Since it may not be possible to create a complete environment for running a program
on the host machine, the recommended strategy is to build “scaffolding” code to
emulate the target device and create an environment similar to the target. To
minimize the development efforts for this scaffolding code, engineers will not put
effort into creating a high-fidelity emulation, but one good enough to exercise the
code in question.
In addition, the host machine is frequently configured to be similar in file structure as
the remote machine or a directory is created to resemble the root file system of the
target and the program performs a chroot() when starting. Following this strategy
allows the developer to create a separate environment that is closer to that of the
target, that is with the same set of files, permissions, libraries and device nodes
without interfering with the host machine’s configuration. The chroot() strategy also
helps reduce regressions that can happen when recompiling and testing the program
on the target machine.

Building Related Projects in a workspace
In TimeStorm, projects are not hierarchical. This is much different than other systems
where a project is frequently structured as a top-level directory with a directory for
each component, with those directories nesting downward. For example
top-level-dir/
application
shared-lib-1/
static-lib-1/
static-lib-2/
shared-lib-2/
static-lib-1/
static-lib-2/

In this project, the user would typically write a make file that built the projects in the
following order:
shared-lib-2/static-lib-2/
shared-lib-2/static-lib-1/
shared-lib-1/static-lib-2/
shared-lib-1/static-lib-1/
application/

In TimeStorm, since all of the projects are peers of each other, enforcing the build
order would occur through Project References, which part of the project properties.
To access the Project References, open the project properties dialog by right clicking
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and selecting Properties, then selecting the Project References entry on the left. The
dialog will look like the following

Figure 24: Project References Panel

By selecting entries in this dialog, TimeStorm build those projects before the current
project (if, in fact, they needed to be rebuilt). Project references can be nested
several levels deep, so that if a referenced project has other references, those
references will be rebuilt, if necessary, as well, ensuring that the top-level project has
all of its dependencies built before starting its built. In this way, the developer has
the same degree of control as one would have when using a traditional “nested”
make file.
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A DVANCED T OPICS
Automatic Updates
The standalone TimeStorm IDE will automatically search for updates from Timesys
when it starts by contacting http://updates.timesys.com/timestorm. When updates
are available, a dialog will appear asking it the updates should be installed. To
update the TimeStorm plugins installed in a 3rd party Eclipse IDE, select Help >
Software Updates from the menu.

Update Process
The update process will show you where TimeStorm found updates. When TimeStorm
was installed, it was configured to look at a URL supplied by Timesys. Other plug-ins
may also have added a URL for automatic updates, so this dialog may show additional
features.
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The next few dialogs will display the license and the exact parts of the software
TimeStorm will be updating. After accepting the license, press the Finish button to
begin installation of the update. After pressing Finish, TimeStorm will download the
update in the background. The progress of the download is shown in the bottom right
corner of the main winow, as seen in Figure 26. When the download finishes,
TimeStorm will need to be restarted in order for the update process to be completed.

Figure 26: Updating TimeStorm Components

Disabling Updates
To stop TimeStorm from checking for updates, open the preferences panel and
navigate to Install/Update > Automatic Updates. On the right side of the panel,
uncheck the Automatically find new updates and notify me check box and click on OK.

Figure 27: Toggle Automatic Updates
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Building from the Command Line
TimeStorm has been designed so that projects can be built from the command-line as
well as the IDE. This feature exists so that customers with build systems can easily
integrate projects created with TimeStorm into their automated build system.
As part of the build process, TimeStorm scans the current project and builds a list of
files in the project as well as the dependencies on other files in the project.
TimeStorm then uses that dependency list, along with the information in the build
configuration, to create several GNU make files. TimeStorm then builds the project
by executing make with the generated files to perform the build steps. Each build
configuration creates a make file in a directory named after the build configuration
under the project directory.
For example
<workspace>/my-project/Debug/

makefile
<workspace>/my-project/Profile/
makefile

The make file overrides the following standard variables to control what tools are
used in the standard make build rules.
RANLIB
CPP
AS
AR
OBJCOPY
DEBUGGER
STRIP
OBJDUMP
CC
NM
CXX
LD

Each of these tools is changed to use the location the tool chain of the development
host. If the location is different on the build machine, one of the following strategies
followed:
Create symlinks – this is the easiest path. On the build machine, create symbolic
links to the tools in the location where the make file expects them to be. Going this
route introduces a configuration dependency on the build machine, so this should
documented by the build team, and, in the best of situations, a script should be
created to automate the creation of the links.
Set environment variables – with make, if an environment variable is set, it will not
be overridden by a make variable. The script that runs the make file will need to set
all of these variables to the right location before invoking make.
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Auxiliary Files
TimeStorm will over-write the make file each time is performs a build. In order to
allow for maximum customization, TimeStorm builds the make file with several
optionally included files. Optionally included files are incorporated into the make file
if they exist; otherwise, if the file does not exist, the reference to the file is ignored.
TimeStorm optionally includes these files:
…/makefile.init – This file is called at the beginning of the makefile. It can be used to
customize initialization.
../makefile.defs – This file is called after initialization, but before objects are
compiled. It can be used to supply custom macro definitions.
../makefile.targets – This file is called at the end of the makefile. It can be used to
supply customized target information.
Notice TimeStorm will look for the files in the parent of the build configuration
directory. This makes it easy to share make file customizations across build
configurations.

Using Source Code Control from the Command-line
Some organizations use a source code control (SCC) system that can only be used
from the command-line or some other external tool. TimeStorm can be used with
these tools as long as care is taken in what files are placed under source control and
other configuration measures are taken. This section lists out the files and directories
that should not be placed under SCC and other per-file configuration information.
File or Directory/

Notes

Workspace
<workspace>/.metadata

This directory contains state information,
such as window positioning, for the
current workspace.
Exclude this entire directory from SCC
management.

C / C++ Projects
<workspace>/<c project>/.cproject
<workspace>/<c project>/.products
<workspace>/<c project>/.project

These files contain project-oriented
information, such as what appears in the
properties dialog for a project.
Add all of these files into source control.
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